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ALLEGATO 4A – PROTOCOLLO PER L’ESECUZIONE DELLE PROVE 

FUNZIONALI 

 

 
GARA A PROCEDURA APERTA PER LA CONCLUSIONE DI UN ACCORDO 

QUADRO, PER OGNI LOTTO, AVENTE AD OGGETTO LA FORNITURA DI 

TOMOGRAFI COMPUTERIZZATI (TC), SERVIZI CONNESSI, DISPOSITIVI E 

SERVIZI ACCESSORI PER LE PUBBLICHE AMMINISTRAZIONI AI SENSI 

DELL’ART. 54, COMMA 4, LETT. A),D. LGS. N. 50/2016 
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1. OGGETTO E SCOPO 

Il presente documento descrive le procedure di misura e le modalità di presentazione dei risultati delle 

elaborazioni relative ai parametri funzionali delle seguenti apparecchiature: 

 Lotto 1 - Tomografi Computerizzati (TC) General Purpose; 

 Lotto 2 - Tomografi Computerizzati (TC) Cardio. 

 

 

2. INDICAZIONI PRELIMINARI 

- Il concorrente dovrà realizzare le misure descritte in questo protocollo, sotto la sua esclusiva 

responsabilità, secondo i parametri relativi alle condizioni operative previste da ciascuna prova; 

- il concorrente dovrà fornire tutti i dati acquisiti o elaborati secondo lo schema contenuto nel 

presente protocollo; 

- l’elaborazione delle immagini ed il calcolo dei parametri fisici, secondo quanto descritto in 

ciascuna prova, dovrà essere realizzata dal concorrente; 

- le immagini prodotte durante lo svolgimento della verifica funzionale da parte della Commissione 

di gara, saranno salvate, senza alcun ulteriore processing, in CD o DVD in formato DICOM non 

compresso; 

- all’interno del CD o DVD saranno presenti le immagini della verifica funzionale, suddivise 

possibilmente in cartelle identificate con il nome di ogni singola prova. 

 

Durante lo svolgimento delle prove da parte del concorrente sarà sua cura riportare i parametri di 

impostazione delle apparecchiature richiesti nel modulo predisposto (“Allegato 4A bis –Modulo 

registrazione parametri”). 

Al termine delle prove il concorrente eseguirà l’elaborazione delle immagini e dei dati che inserirà a 

Sistema nella Scheda di Offerta Tecnica (par. 6.1 del Capitolato d’Oneri). 

 

 

3. OGGETTI TEST E STRUMENTAZIONE 

Per l’esecuzione di tutte le misure descritte nel presente protocollo si farà uso dei seguenti oggetti test: 

 CTDI Head (PMMA cilindrico 16 cm diametro) 

 CTDI Body (PMMA cilindrico 32 cm diametro) 

 CATPHAN 600 (The Phantom Laboratory) 

 Fantoccio Cono Dose Automatica (EL-SE CT FANTOCCIO CONICO) 

 Simulatore di segnale ECG 
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 Camera a ionizzazione modello pencil (lunghezza 100 mm) e relativo elettrometro, con 

certificato di calibrazione valido 

 Software di analisi automatica (Iris Auto QA Lite vers. 3.1.5.7 o successiva) 

 Software freeware ImageJ (http://imagej.nih.gov) 

 Plugin per software ImageJ SSP messo a disposizione da Consip S.p.A. 

 ROIset per software ImageJ messo a disposizione da Consip S.p.A. 

 

 

4. LEGENDA 

NT o Collimazione totale = è la copertura del fascio lungo Z, data dal prodotto del numero di strati 

ricostruiti (N) per lo spessore di singolo strato (T); 

CTDIw = Indice di dose pesato in Tomografia Computerizzata. Il calcolo del CTDIw avviene come da 

standard internazionale: 

Utilizzare sequenzialmente gli oggetti test CTDI HEAD e BODY con la camera a ionizzazione pencil posta 

al centro (Dcentro) e nei quattro fori periferici (la media delle quattro misure in periferia forniscono il 

valore Dperiferia). Eseguire le misure di CTDIw con singola rotazione del tubo al centro della camera pencil. 

Calcolare quindi il CTDIw secondo la formula standard. 

CTDIvol = Indice di dose volumetrico in tomografia computerizzata. Il valore CTDIvol si calcola a partire dal 

CTDIw misurato in assiale con la stessa collimazione del fascio, dividendolo per il valore del pitch 

impiegato. 

CTDIvol corretto = valore di CTDIvol indicato dal tomografo moltiplicato per il fattore di correzione (Fcorr) 

ricavato nella verifica dell’accuratezza del CTDI come descritto nel relativo paragrafo. 

FOV (Field of View) = Diametro del campo di vista. Quando non diversamente specificato, si intende il 

valore del campo di vista in ricostruzione. 

FWHM (Full Width at Half-Maximum) = Larghezza a metà altezza di un profilo. 

ROI di riferimento = Region of Interest circolare di diametro 1 cm posizionata nell’immagine centrale 

dell’oggetto test al centro di una zona omogenea, come indicato nel dettaglio nella prova E. 

 

 

5. ELENCO DELLE PROVE E INDICAZIONI SULL’ESECUZIONE 

Lotto 1: 

 Prova Oggetti test 

0 
Verifica accuratezza CTDI e determinazione Fattore di 
Correzione 

CTDI Head; camera pencil 

1A 
Indicatore di qualità di risoluzione spaziale e rumore 
(Q factor) 

CATPHAN 600 

http://imagej.nih.gov/
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 Prova Oggetti test 

1B Omogeneità di rumore CATPHAN 600 

1C Risoluzione a basso contrasto CATPHAN 600 

1D Accuratezza spessore di strato CATPHAN 600 

1E Omogeneità di rumore in modulazione volumetrica CONO DOSE AUTOMATICA 

 

Lotto 2: 

 Prova Oggetti test 

0 
Verifica accuratezza CTDI e determinazione Fattore di 
Correzione 

CTDI Head; CTDI Body; camera pencil 

2A 
Indicatore di qualità di risoluzione spaziale e rumore 
(Q factor) 

CATPHAN 600 

2B Omogeneità di rumore CATPHAN 600 

2C Risoluzione a basso contrasto CATPHAN 600 

2D Omogeneità di spessore di strato CATPHAN 600 

2E Omogeneità di rumore in modulazione volumetrica CONO DOSE AUTOMATICA 

2F Risoluzione spaziale in modalità cardiaca CATPHAN 600 

 

1. Le prove devono essere eseguite su acquisizioni effettuate in base al relativo protocollo, come 

di seguito descritto per le singole prove. 

2. Per l’acquisizione di ogni immagine o serie di immagini richieste da ciascuna prova è consentita 

(necessaria nella prova E) l’acquisizione di immagini scout/surview/topogram/scanogram al fine 

di garantire un’ottimale centratura degli oggetti test e un funzionamento ottimizzato degli 

automatismi per il controllo dei mA. 

 

 

5.1. PROVE FUNZIONALI TOMOGRAFI COMPUTERIZZATI LOTTO 1 

Per l’esecuzione di ciascuna prova occorrerà seguire le istruzioni del presente protocollo. 

Nota bene: anche con FOV 250 (o 240) mm impostare un filtro/algoritmo di ricostruzione di tipo body, 

non head/brain, per evitare sovra-correzioni per la teca cranica. 
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5.1.1. MISURA PRELIMINARE - VERIFICA ACCURATEZZA CTDI E 
DETERMINAZIONE FATTORE DI CORREZIONE 

Come prerequisito all’esecuzione delle prove, devono essere effettuate misure di CTDI Head, 

verificando l’accuratezza del valore nominale indicato a monitor e individuando il fattore di correzione 

da applicare ove richiesto nelle procedure di seguito dettagliate. 

 

1. Posizionare il fantoccio CTDI Head sul craniostato in dotazione alla TC. 

2. Posizionare la camera pencil 100 mm tarata. 

3. Impostare il protocollo di scansione nel modo seguente: 

 

Parametro Valore Note 

Modalità Assiale  

Tensione 120 kV Se non disponibile 110 kV 

FOV 250 mm Se non disponibile 240 mm 

Collimazione totale 19 mm -20 mm Ammesso qualunque valore nell’intervallo indicato 

Tempo rotazione 1 secondo  

Corrente Vedi note Valore di mA tale da ottenere un valore a monitor di 

CTDIvol (fantoccio Head 16cm) il più prossimo possibile 

a 40 mGy (e comunque entro ±2 mGy) 

 

4. Effettuare 5 misure ripetute per ognuno dei fori in cui si posiziona la camera per la misura del 

CTDI. 

5. Effettuare la media delle misure ripetute e calcolare il CTDIw secondo definizione. 

6. Ai sensi delle norme tecniche vigenti la differenza tra i valori di CTDIvol indicati e i CTDIw medi 

misurati dovranno essere inferiori al 20%, in caso contrario il tomografo non è da ritenersi 

idoneo per l’esecuzione delle prove funzionali. 

7. Determinare il fattore di correzione per il fantoccio Head da applicare ai valori di CTDIvol indicati 

a monitor per l’esecuzione delle prove successive nel modo seguente: 

indicatoCTDI

misuratoCTDI
F

vol

W

corr   

SCOSTAMENTI ACCETTABILI 

Lo scostamento accettabile, pena l’esclusione del concorrente, tra il valore della misura del parametro 

dal concorrente (CTDIw,head,concorrente) e i risultati della medesima misura ripetute dalla Commissione di 

gara (CTDIw,head,commissione), nell’ambito della verifica funzionale di cui al paragrafo 9.4.2 del Capitolato 

d’oneri, è inferiore o uguale a ±10%, ovvero: 

-10% ≤ [(CTDIw,head,concorrente - CTDIw,head,commissione) / CTDIw,head,commissione] ≤ +10% 
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5.1.2. PROVA 1A - INDICATORE DI QUALITÀ DI RISOLUZIONE SPAZIALE E RUMORE (Q 

FACTOR) 

1. Posizionare il fantoccio CATPHAN sul lettino, centrandolo rispetto all'inserto CTP404 con 

l’ausilio delle indicazioni laser. 

2. Definire lo strato di riferimento "zero" sul centro dell'inserto CTP404. 

3. Impostare i parametri di acquisizione nel modo seguente: 

Parametro Valore Note 

Modalità Assiale  

Tensione 120 kV Se non disponibile 110 kV 

FOV 250 mm Se non disponibile 240 mm 

Collimazione totale 19 mm - 20 

mm 

Ammesso qualunque valore nell’intervallo indicato 

Spessore strato ricostruito 2,5 mm Se non disponibile valore più vicino a 2,5 mm, 

nell'intervallo compreso tra 2,0 e 2,5 mm 

Tempo rotazione 1 secondo  

Corrente Vedi note Valore di mA tale da ottenere un valore di CTDIvol 

corretto con fantoccio Head il più prossimo possibile 

a 40 mGy (e comunque entro ±2 mGy) 

Matrice 512x512  

Filtro/Kernel ricostruzione Standard Il filtro di ricostruzione deve essere scelto tra quelli 

abitualmente impiegati nella clinica ed utilizzato 

anche per le immagini sottoposte alla valutazione 

clinica 

4. Mantenendo i parametri sopra indicati, effettuare le acquisizioni elencate in tabella: 

Gruppo 

serie 

Centratura su 

inserto 

Elementi di 

interesse per 

l'analisi 

Posizione 

relativa centro 

scansione 

N° 

ripetizioni 

Algoritmo di 

ricostruzione 

FBP 

CTP404 Rampe 0 mm 1 
Filtered Back 

Projection (FBP) 

senza utilizzo di 

iterativo 

CTP528 - 10 

mm 
Bead -80 mm 5 

CTP486 
Sezione 

uniforme 
-160 mm 5 

Iterativo 

CTP404 Rampe 0 mm 1 

Iterativo con grado 

di intensità scelto 

liberamente 

CTP528 - 10 

mm 
Bead -80 mm 5 

CTP486 
Sezione 

uniforme 
-160 mm 5 

5. Per l'elaborazione, importare le 11 serie di immagini del gruppo FBP nel software AutoQALite 

versione 3.1.5.7 o successiva. 
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6. Effettuare l'analisi. 

7. Considerare i valori di risoluzione spaziale in termini di lp/mm al 50% della MTF calcolate 

sull'elemento Bead per le 5 immagini ripetute relative alle acquisizioni FBP: 

fMTF50% fbp
(k)

 = frequenza (lp/mm) corrispondente al 50% della curva MTF relativa alla 

ripetizione k-esima. 

8. Considerare i valori di rumore misurati sulla sezione uniforme centrale (indicati con Noise dal 

software): 

DSfbp 
(k)

 = deviazione standard dei numeri TC nella ROI circolare di diametro pari al 40% del 

diametro del fantoccio, relativa alla ripetizione k-esima. 

9. Calcolare per ogni serie i valori medi: 

DSfbp,m = MEDIAk=1,...,5 ( DSfbp 
(k)

) 

fMTF50% fbp,m = MEDIAk=1,...,5 (fMTF50% fbp
(k)

) 

10. Utilizzando lo spessore di strato nominale z e il valore di CTDIvol corretto, calcolare il parametro 

Qfbp come segue: 

 
  volmfbp

mfbpMTF

fbp
CTDIzDS

f
Q




2

,

3

,%,50

 
11. Importare le 11 serie di immagini del gruppo 2 iterativo nel software AutoQALite versione 

3.1.5.7 o successiva. 

12. Effettuare l'analisi. 

13. Considerare i valori di risoluzione spaziale in termini di lp/mm al 50% della MTF calcolate 

sull'elemento Bead per le 5 immagini ripetute relative alle acquisizioni con algoritmo iterativo: 

fMTF50% iter
(k)

 = frequenza (lp/mm) corrispondente al 50% della curva MTF, relativa alla 

ripetizione k-esima. 

14. Considerare i valori di rumore misurati sulla sezione uniforme (indicati con Noise dal software): 

DSiter 
(k)

 = deviazione standard dei numeri TC nella ROI circolare di diametro pari al 40% del 

diametro del fantoccio, relativa alla ripetizione k-esima. 

15. Calcolare per ogni serie i valori medi: 

DSiter,m = MEDIAk=1,…,5 ( DSiter 
(k)

) 

fMTF50% iter,m = MEDIAk=1,…,5 (fMTF50% iter
(k)

) 

16. Utilizzando lo spessore di strato nominale z e il valore di CTDIvol corretto, calcolare il parametro 

Qfbp come segue: 



 

Classificazione Consip Public 

Gara a procedura aperta ai sensi del D.Lgs. 50/2016 e s.m.i., per la conclusione di un Accordo Quadro per ogni 
Lotto per la fornitura di Tomografi Computerizzati (TC), servizi connessi, dispositivi e servizi accessori per le 
Pubbliche Amministrazioni ai sensi dell’art. 54, comma 4, lett a), del D. Lgs. n. 50/2016 – ID 1856 

Allegato 4A – Protocollo per l’esecuzione delle prove funzionali 

Pag. 9 di 33 

 

 
  volmiter

miterMTF

iter
CTDIzDS

f
Q




2

,

3

,%,50

 

17. Calcolare il parametro QF come segue: 

QF = (Qfbp + Qiter) / 2 

 

SCOSTAMENTI ACCETTABILI 

Gli scostamenti accettabili, pena l’esclusione del concorrente, tra i valori delle misure dei parametri 

dichiarati dal concorrente (DSfbp,m,Concorrente, fMTF50%fbp,m,Concorrente, DSiter,m,Concorrente, fMTF50%iter,m,Concorrente) e i 

risultati delle medesime misure ripetute dalla Commissione di gara (DSfbp,m,Commissione, 

fMTF50%fbp,m,Commissione, DSiter,m,Commissione, fMTF50%iter,m,Commissione), nell’ambito della verifica funzionale di cui al 

paragrafo 9.4.2 del Capitolato d’oneri, sono i seguenti: 

[(DSfbp,m,Concorrente - DSfbp,m,Commissione) / DSfbp,m,Commissione] ≥ -10% 

[(fMTF50%fbp,m,Concorrente - fMTF50%fbp,m,Commissione) / fMTF50%fbp,m,Commissione] ≤ +10% 

[(DSiter,m,Concorrente - DSiter,m,Commissione)/ DSiter,m,Commissione] ≥ -10% 

[(fMTF50%iter,m,Concorrente - fMTF50%iter,m,Commissione)/ fMTF50%iter,m,Commissione] ≤ +10% 

 

 

5.1.3. PROVA 1B – OMOGENEITÀ DI RUMORE 

Posizionare il fantoccio CATPHAN sul lettino, centrandolo rispetto all'inserto CTP404 con l’ausilio delle 

indicazioni laser. 

1. Definire lo strato di riferimento "zero" sul centro dell'inserto CTP404. 

2. Impostare i parametri di acquisizione nel modo seguente: 
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3. Mantenendo i parametri sopra indicati, effettuare le acquisizioni elencate in tabella: 

 

4. Importare le 5 serie di immagini (che indichiamo con indice k = 1, 2, 3, 4, 5) dell’inserto 

uniforme CTP486 e l’immagine di riferimento dell’inserto CTP404 nel software AutoQALite 

versione 3.1.5.7 o successiva. 

5. Effettuare l'analisi. 

6. Considerare i valori di rumore per le singole sezioni uniformi riferiti alla ROI circolare di 

diametro pari al 40% del diametro del fantoccio (indicati con Noise dal software). 

7. Data la serie k, per ogni slice j-esima (j = 1, …, N con N ≥ 32) del modulo uniforme del fantoccio, 

estrarre dai risultati forniti dal software il valore di Noise: 

DSj 
(k)

  = deviazione standard dei numeri TC nella ROI circolare di diametro pari al 40% del 

diametro del fantoccio 

8. Calcolare la deviazione standard del singolo strato mediata sulle 5 acquisizioni ripetute: 

DSj = MEDIAk=1,…,5 ( DS j 
(k)

) 

Parametro Valore Note 

Modalità Assiale  

Tensione 120 kV Se non disponibile 110 kV 

FOV 250 mm Se non disponibile 240 mm 

Collimazione totale  19 mm - 20 

mm 

Ammesso qualunque valore nell’intervallo indicato. 

Configurazione con il massimo numero di strati 

disponibile con questa collimazione e comunque non 

inferiore a 32 strati. 

Spessore strato ricostruito < 1 mm Minimo spessore disponibile 

Tempo rotazione 1 secondo  

Corrente Vedi note Valore di mA tale da ottenere un valore di CTDIvol 

corretto con fantoccio Head il più prossimo possibile 

a 40 mGy (e comunque entro ±2 mGy) 

Matrice 512x512  

Filtro/Kernel ricostruzione Standard Il filtro di ricostruzione deve essere scelto tra quelli 

abitualmente impiegati nella clinica ed utilizzato 

anche per le immagini sottoposte alla valutazione 

clinica 

Gruppo 

serie 

Centratura su 

inserto 

Elementi di 

interesse per 

l'analisi 

Posizione 

relativa centro 

scansione 

N° 

ripetizioni 

Algoritmo di 

ricostruzione 

Unica 

CTP404 Rampe 0 mm 1 
Filtered Back 

Projection (FBP) 

senza utilizzo di 

iterativo 
CTP486 

Sezione 

uniforme 
-160 mm 5 
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9. Calcolare la deviazione standard media tra tutti gli strati: 

DSmedia = MEDIA j=1,..,N ( DS j) 

10. Calcolare la deviazione relativa del rumore del singolo strato rispetto al valore medio: 

R j = abs[( DSj - DSmedia ) / DSmedia] 

11. Ricavare la massima deviazione relativa: 

RM = MAXj=1,…,N ( R j ) 

12. Ricavare il parametro OR: 

OR = 1 - RM 

 

SCOSTAMENTI ACCETTABILI 

La differenza accettabile, pena l’esclusione del concorrente, tra il valore della misura del parametro 

dichiarato dal concorrente (ORConcorrente) e il risultato della medesima misura ripetuta dalla Commissione 

di gara (ORCommissione), nell’ambito della verifica funzionale di cui al paragrafo 9.4.2 del Capitolato d’oneri, 

è inferiore o uguale a +0,1 , ovvero: 

(ORConcorrente - ORCommissione ) ≤ +0,1 

 

 

5.1.4. PROVA 1C - RISOLUZIONE A BASSO CONTRASTO 

1. Posizionare il fantoccio CATPHAN sul lettino, centrandolo rispetto all'inserto CTP404 con 

l’ausilio delle indicazioni laser. 

2. Definire lo strato di riferimento "zero" sul centro dell'inserto CTP404. 

3. Impostare i parametri di acquisizione nel modo seguente: 
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4. Mantenendo i parametri sopra indicati, effettuare le acquisizioni elencate in tabella: 

 

5. Importare le 6 immagini ricostruite con FBP (la sezione centrale dell’inserto CTP404 e le 5 

sezioni centrali del CTP515) nel software AutoQALite versione 3.1.5.7 o successiva. 

6. Effettuare l'analisi. 

7. Per ogni immagine k-esima della sezione centrale dell’inserto CTP515 (k = 1, 2, 3, 4, 5), ricavare i 

valori di CNR per i primi 6 inserti supra-slice target di contrasto nominale 1% (diametro 

rispettivamente 15, 9, 8, 7, 6 e 5 mm) e calcolarne la media, indicandola con CNRFBP 
(k)

: 

CNRFBP 
(k)

 = [CNR15,FBP
(k) 

+ CNR9,FBP
(k) 

+ CNR8,FBP
(k) 

+ CNR7,FBP
(k)

 + CNR6,FBP
(k)

 + CNR5,FBP
(k)

] / 6 

8. Calcolare quindi la media tra le 5 serie ripetute: 

Parametro Valore Note 

Modalità Spirale  

Tensione 120 kV Se non disponibile 110 kV 

FOV 250 mm Se non disponibile 240 mm 

Collimazione totale 19 mm - 20 

mm 

Ammesso qualunque valore nell’intervallo indicato 

Spessore strato ricostruito 5,0 mm Se non disponibile valore più vicino a 5,0 mm, 

nell'intervallo compreso tra 4,5 e 5,0 mm 

Tempo rotazione 1 secondo  

Pitch Vicino a 1,0 Valore disponibile più vicino a 1,0, nell’intervallo 

compreso tra 0,85 e 1,15 

Corrente Vedi note Valore di mA tale da ottenere un valore di CTDIvol 

corretto con fantoccio Head il più prossimo possibile 

a 40 mGy (e comunque entro ±2 mGy) 

Matrice 512x512  

Filtro/Kernel ricostruzione Standard Il filtro di ricostruzione deve essere scelto tra quelli 

abitualmente impiegati nella clinica ed utilizzato 

anche per le immagini sottoposte alla valutazione 

clinica 

Gruppo 

serie 

Centratura su 

inserto 

Elementi di 

interesse per 

l'analisi 

Posizione 

relativa centro 

scansione 

N° 

ripetizioni 

Algoritmo di 

ricostruzione 

FBP 

CTP404 Rampe 0 mm 1 Filtered Back 

Projection (FBP) 

senza utilizzo di 

iterativo 
CTP515 Inserti basso 

contrasto 
-110 mm 5 

Iterativo 

CTP404 Rampe 0 mm 1 Iterativo con grado 

di intensità scelto 

liberamente CTP515 Inserti basso 

contrasto 
-110 mm 5 
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CNRm FBP= MEDIAk=1,…,5 (CNRFBP 
(k)

) 

9. Importare le 6 immagini del gruppo Iterativo (la sezione centrale dell’inserto CTP404 e le 5 

sezioni centrali del CTP515) nel software AutoQALite versione 3.1.5.7 o successiva. 

10. Effettuare l'analisi. 

11. Per ogni immagine k-esima della sezione centrale dell’inserto CTP515 (k = 1,2,3,4,5), ricavare i 

valori di CNR per i primi 6 inserti supra-slice target di contrasto nominale 1% (diametro 

rispettivamente 15, 9, 8, 7, 6 e 5 mm) e calcolarne la media, indicandola con CNRITER 
(k)

: 

CNRITER 
(k)

 = [CNR15,ITER
(k) 

+ CNR9,ITER
(k) 

+ CNR8,ITER
(k) 

+ CNR7,ITER
(k)

 + CNR6,ITER
(k)

 + CNR5,ITER
(k)

] / 6 

12. Calcolare quindi la media tra le 5 serie ripetute: 

CNRm ITER = MEDIAk=1,…,5 ( CNRITER 
(k)

) 

13. Calcolare il parametro finale come segue: 

RBC = (CNRmFBP+ CNRmITER)/2 

 

SCOSTAMENTI ACCETTABILI 

Lo scostamento accettabile, pena l’esclusione del concorrente, tra il valore della misura del parametro 

dichiarato dal concorrente (RBCConcorrente) e il risultato della medesima misura ripetuta dalla 

Commissione di gara (RBCCommissione), nell’ambito della verifica funzionale di cui al paragrafo 9.4.2 del 

Capitolato d’oneri, è inferiore o uguale a +10%,ovvero: 

[(RBCConcorrente - RBCCommissione)/ RBCCommissione] ≤ +10% 

 

 

5.1.5. PROVA 1D – ACCURATEZZA DELLO SPESSORE DI STRATO 

1. Posizionare il fantoccio CATPHAN sul lettino, centrandolo rispetto all'inserto CTP528 con 

l’ausilio delle indicazioni laser. 

2. Definire lo strato di riferimento "zero" sul centro dell'inserto CTP528. 

3. Impostare i parametri di acquisizione nel modo seguente: 
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4. Mantenendo i parametri sopra indicati, effettuare le acquisizioni elencate in tabella: 

 

5. Data la serie k (k = 1, 2, 3, 4, 5), ricostruita con passo 0,1mm, individuare la slice in cui compare 

il pallino (“Bead”) dell’inserto CTP528+10mm (posizione relativa = 80mm) con massima 

intensità, estrapolarla insieme a tutte le slice precedenti e successive in un intervallo di ±3 mm 

(posizioni relative da -77 a -83 mm). 

6. Collocare le immagini estrapolate in apposite cartelle (una per ogni serie). 

7. Caricare la cartella SSP contenente il relativo plugin nella cartella di ImageJ (percorso 

C:\Program Files\ImageJ\plugins). 

Parametro Valore Note 

Modalità Spirale  

Tensione 120 kV Se non disponibile 110 kV 

FOV 250 mm Se non disponibile 240 mm 

Collimazione totale 19 mm - 20 

mm 

Ammesso qualunque valore nell’intervallo indicato. 

Configurazione con il massimo numero di strati 

disponibile con questa collimazione e comunque non 

inferiore a 32 strati 

Spessore strato ricostruito < 1 mm Minimo spessore disponibile 

Tempo rotazione 1 secondo  

Pitch Vicino a 1,0 Valore disponibile più vicino a 1,0, nell’intervallo 

compreso tra 0,85 e 1,15 

Corrente Vedi note Valore di mA tale da ottenere un valore di CTDIvol 

corretto con fantoccio Head il più prossimo possibile 

a 40 mGy (e comunque entro ±2 mGy) 

Matrice 512x512  

Filtro/Kernel ricostruzione Standard Il filtro di ricostruzione deve essere scelto tra quelli 

abitualmente impiegati nella clinica ed utilizzato 

anche per le immagini sottoposte alla valutazione 

clinica 

Gruppo 

serie 

Centratura su 

inserto 

Elementi di 

interesse per 

l'analisi 

Posizione 

relativa centro 

scansione 

N° 

ripetizioni 
Algoritmo di ricostruzione 

FBP 

 

CTP528 - 10 

mm 

 

Bead 

 

-80 mm 

 

5 

Filtered Back Projection (FBP) 

senza utilizzo di iterativo. 

Ricostruire dalla posizione 

z=-77 a z=-83 con distanza tra 

le fette (incremento/feed) 

minima, possibilmente 0,1 

mm. 
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8. Avviare ImageJ e con il comando “File→ Import → Image sequence” selezionare la prima 

immagine di quelle estrapolate per la prima serie (k=1). 

9. Scorrendo la barra inferiore, sotto all’immagine, posizionarsi su una delle immagini della serie 

in cui è ben visibile l’inserto “Bead” del fantoccio (ai fini del risultato finale non è determinante 

l’immagine che si seleziona in questa fase, la cui funzione è limitata alla centratura della ROI). 

10. Disegnare una ROI circolare di diametro 8 pixel (circa 4 mm per un FOV di 250 mm) centrata 

sull’inserto “Bead”. 

11. Lanciare il plugin fornito “SSP” (comando “Plugins  SSP  SSP). 

12. Annotare il risultato ottenuto come ampiezza a metà altezza del profilo di sensibilità dello 

strato FWHM
(k)

. 

13. Ripetere per le altre serie (k= 2, 3, 4, 5). 

14. Calcolare la FWHM media: 

FWHMm = MEDIAk=1,…,5 (FWHM 
(k)

) 

15. Considerando lo spessore T nominale dello strato, ricavare il parametro finale: 

ASS = 1 - [abs (FWHMm - T) / T] 

 

SCOSTAMENTI ACCETTABILI 

Lo scostamento accettabile, pena l’esclusione del concorrente, tra il valore della misura del parametro 

dichiarato dal concorrente (ASSConcorrente) e il risultato della medesima misura ripetuta dalla Commissione 

di gara (ASSCommissione), nell’ambito della verifica funzionale di cui al paragrafo 9.4.2 del Capitolato 

d’oneri, è inferiore o uguale a 0,1, ovvero: 

(ASSConcorrente - ASSCommissione ) ≤ +0,1 

 

 

5.1.6. PROVA 1E – OMOGENEITÀ DI RUMORE IN MODULAZIONE VOLUMETRICA 

1. Posizionare il fantoccio conico sul lettino centrando la zona da acquisire con l’ausilio del sistema 

di centratura, avendo in particolare cura che l’asse di simmetria dell’oggetto test sia 

coincidente con l’asse di rotazione del tomografo. 

2. Eseguire una scout/scanogram/topogram/surview in direzione caudo-craniale o Piedi-Testa (in 

configurazione head-first), con corrente circa 1/3 di quella impiegata nella prova 1A. 

3. Impostare i parametri di acquisizione nel modo seguente: 
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4. Acquisire quindi la scansione TC impostando gli estremi di scansione in modo da acquisire i 

primi 11 gradoni dell’oggetto test, escludendo i due settori più grandi, in direzione caudo-

craniale o piedi-testa (in configurazione head first), dagli spessori maggiori verso gli spessori 

minori, come segue: 

 

 
 

5. Eseguire in tutto 5 scansioni ripetute. 

Parametro Valore Note 

Modalità Spirale  

Tensione 120 kV Se non disponibile 110 kV 

FOV 500 mm  

Collimazione totale 19 mm - 20 

mm 

Ammesso qualunque valore nell’intervallo indicato 

Spessore strato ricostruito 2,5 mm Se non disponibile valore più vicino a 2,5 mm, 

nell'intervallo compreso tra 2,0 e 2,5 mm 

Tempo rotazione 1 secondo  

Pitch Vicino a 1,0 Valore disponibile più vicino a 1,0, nell’intervallo 

compreso tra 0,85 e 1,15 

Corrente Vedi note Automatismo per la MODULAZIONE VOLUMETRICA 

della corrente inserito (massima variabilità 

disponibile). 

Impostare l’automatismo per il controllo della 

corrente in modo tale da ottenere, nell’oggetto test 

DOSE AUTOMATICA CONO, una deviazione standard 

dei n.CT nella ROI di riferimento pari a (12 ± 2) HU 

Matrice 512x512  

Filtro/Kernel ricostruzione Standard Il filtro di ricostruzione deve essere scelto tra quelli 

abitualmente impiegati nella clinica ed utilizzato 

anche per le immagini sottoposte alla valutazione 

clinica 
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6. Eseguire la valutazione solo nei 9 strati centrali che compongono l’oggetto test (escludendo 

cioè anche i due gradoni di dimensioni minime, oltre ai 2 di dimensioni massime che già erano 

stati esclusi in fase di acquisizione). 

7. Per ciascuna serie di immagini, individuare la fetta centrale di ogni scalino dell’oggetto test 

(dalla 1 alla 9, come in figura), distanziate di 20 mm l’una dall’altra. 

8. Collocare le immagini estrapolate in 5 apposite cartelle, una cartella per ogni serie acquisita. 

9. Avviare ImageJ e con il comando “File” → “Import” → “Image sequence” andare nella prima 

cartella e selezionare la prima immagine. 

10. Nella finestra di dialogo che si aprirà automaticamente, confermare che sono 9 immagini e dare 

OK. 

11. Cliccare su “Analyze” → “Tools” → “ROI Manager”, in modo da aprire la finestra “ROI 

Manager”. 

12. Premere il tasto “More” → “Options” e selezionare l’opzione “Associate “Show All” ROIs with 

slices”, quindi dare OK. 

13. Premere poi il tasto “More” → “Open” e selezionare il set di ROI fornito (file 

“RoiSet_cono_sequence.zip”), facendo attenzione a caricare l’intero file zip senza averlo 

precedentemente decompresso. 

14. Premendo infine la spunta su “Show All” si potrà verificare che ImageJ abbia assegnato in modo 

ordinato le ROI alle slices corrette (vedi figura relativa alla prima immagine). 

 

15. Verificare su “Analyze” → “Set Measurements” che siano selezionati almeno i parametri 

“Standard deviation”, “Centroid” e “Display label”. 

16. Se il centro dell’oggetto test non cade esattamente nella posizione (X,Y) = (250mm,250mm), 

sarà necessario traslare tutte le ROI di un numero di pixel opportuno, usando il tasto “More → 

Translate”. 

17. Sulla finestra ROI Manager premere il tasto “Measure” per eseguire l’analisi completa delle 9 

immagini. 

18. Calcolare il valor medio delle standard deviation delle 4 ROI di ciascuno scalino: 
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DSi 
(k)

 = media della deviazione standard dei numeri TC nelle 4 ROI posizionate nello scalino i-

esimo del cono, per la serie di immagini k-esima. 

19. Ripetere per le altre serie (k = 2, 3, 4, 5). 

20. Ricavare il valore medio per le immagini corrispondente ad ogni spessore per le serie ripetute: 

DSm,i = MEDIAk=1,…,5 ( DSi 
(k)

). 

21. In particolare DS5 = il valore medio ottenuto nello scalino centrale (n.5) 

22. Ricavare i valori minimo e massimo: 

DSmin = MINi = 1,...,9 ( DSm,i ) 

DSmax = MAXi = 1,...,9 ( DSm,i ) 

23. Ricavare il parametro finale: 

ORM = 1 - ( DSmax - DSmin) / 12 

 

SCOSTAMENTI ACCETTABILI 

Gli scostamenti accettabili, pena l’esclusione del concorrente, tra i valori delle misure dei parametri 

dichiarati dal concorrente (DSmin,concorrente, DSmax,concorrente) e i risultati delle medesime misure ripetute 

dalla Commissione di gara (DSmin,commissione, DSmax,commissione ), nell’ambito della verifica funzionale di cui al 

paragrafo 9.4.2 del Capitolato d’oneri, è inferiore o uguale a ±10%, ovvero: 

-10% ≤ [(DSmin,concorrente - DSmin,commissione) / DSmin,commissione] ≤ +10% 

-10% ≤ [(DSmax,concorrente - DSmax,commissione) / DSmax,commissione] ≤ +10% 
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5.2. PROVE FUNZIONALI TOMOGRAFI COMPUTERIZZATI LOTTO 2 

Per l’esecuzione di ciascuna prova occorrerà seguire le istruzioni del presente protocollo. 

Nota bene: anche con FOV 250 (o 240) mm impostare un filtro/algoritmo di ricostruzione di tipo body, 

non head/brain, per evitare sovra-correzioni per la teca cranica. 

 

5.2.1. MISURA PRELIMINARE - VERIFICA ACCURATEZZA CTDI E DETERMINAZIONE 

FATTORE DI CORREZIONE  

Come prerequisito all’esecuzione delle prove a punteggio, devono essere effettuate misure di CTDI 

Head e CTDI Body, verificando l’accuratezza del valore nominale indicato a monitor ed individuando il 

fattore di correzione da applicare ove richiesto nelle procedure di seguito dettagliate. 

 

1. Posizionare il fantoccio CTDI Head sul craniostato in dotazione alla TC. 

2. Posizionare la camera pencil 100 mm tarata. 

3. Impostare il protocollo di scansione nel modo seguente: 

 

Parametro Valore Note 

Modalità Assiale  

Tensione 120 kV Se non disponibile 110 kV 

FOV FOV 250 mm Se non disponibile 240 mm 

Collimazione totale 38 mm - 40 

mm 

Ammesso qualunque valore nell’intervallo indicato 

Tempo rotazione 1 secondo  

Corrente Vedi note Valore di mA tale da ottenere un valore a monitor di 

CTDIvol (fantoccio head 16cm) il più prossimo possibile 

a 40 mGy (e comunque entro ±2 mGy) 

 

4. Effettuare 5 misure ripetute per ognuno dei fori in cui si posiziona la camera per la misura del 

CTDI. 

5. Effettuare la media delle misure ripetute e calcolare il CTDIw secondo definizione. 

6. Posizionare il fantoccio CTDI Body sul lettino della TC. 

7. Posizionare la camera pencil 100 mm tarata. 

8. Impostare il protocollo di scansione nel modo seguente: 

 

Parametro Valore Note 

Modalità Assiale  

Tensione 120 kV Se non disponibile 110 kV 

FOV  500 mm  
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Parametro Valore Note 

Collimazione totale 38 mm - 40 

mm 

Ammesso qualunque valore nell’intervallo indicato 

Tempo rotazione 1 secondo  

Corrente Vedi note Valore di mA tale da ottenere un valore a monitor di 

CTDIvol (fantoccio body 32 cm) il più prossimo 

possibile a 15 mGy (e comunque entro ±2 mGy) 

 

9. Effettuare 5 misure ripetute per ognuno dei fori in cui si posiziona la camera per la misura del 

CTDI. 

10. Effettuare la media delle misure ripetute e calcolare il CTDIw secondo definizione. 

11. Ai sensi delle norme tecniche vigenti la differenza tra i valori di CTDIvol indicati e i CTDIw medi 

misurati dovranno essere inferiori al 20%, in caso contrario il tomografo non è da ritenersi 

idoneo per l’esecuzione delle prove funzionali. 

12. Determinare i fattori di correzione per il fantoccio head e body da applicare ai valori di CTDIvol 

indicati a monitor per l’esecuzione delle prove successive nel modo seguente: 

indicatoCTDI

misuratoCTDI
F

vol

W

corr   

SCOSTAMENTI ACCETTABILI 

Gli scostamenti accettabili, pena l’esclusione del concorrente, tra i valori delle misure dei parametri 

dichiarati dal concorrente (CTDIw,head,concorrente, CTDIw,body,concorrente) e i risultati delle medesime misure 

ripetute dalla Commissione di gara (CTDIw,head,commissione, CTDIw,body,commissione), nell’ambito della verifica 

funzionale di cui al paragrafo 9.4.2 del Capitolato d’oneri, è inferiore o uguale a ±10%. 

Ovvero: 

-10% ≤ [(CTDIw,head,concorrente - CTDIw,head,commissione) / CTDIw,head,commissione] ≤ +10% 

-10% ≤ [(CTDIw,body,concorrente - CTDIw,body,commissione) / CTDIw,body,commissione] ≤ +10% 

 

 

5.2.2. PROVA 2A - INDICATORE DI QUALITÀ DI RISOLUZIONE SPAZIALE E RUMORE (Q 

FACTOR) 

1. Posizionare il fantoccio CATPHAN sul lettino, centrandolo rispetto all'inserto CTP404 con 

l’ausilio delle indicazioni laser. 

2. Definire lo strato di riferimento "zero" sul centro dell'inserto CTP404. 

3. Impostare i parametri di acquisizione nel modo seguente: 

Parametro Valore Note 

Modalità Assiale  

Tensione 120 kV Se non disponibile 110 kV 
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Parametro Valore Note 

FOV 250 mm Se non disponibile 240 mm 

Collimazione totale 38 mm - 40 

mm 

Ammesso qualunque valore nell’intervallo indicato 

Spessore strato ricostruito 2,5 mm Se non disponibile valore più vicino a 2,5 mm, 

nell'intervallo compreso tra 2,0 e 2,5 mm 

Tempo rotazione 1 secondo  

Corrente Vedi note Valore di mA tale da ottenere un valore di CTDIvol 

corretto con fantoccio Head il più prossimo possibile 

a 40 mGy (e comunque entro ±2 mGy) 

Matrice 512x512  

Filtro/Kernel ricostruzione Standard Il filtro di ricostruzione deve essere scelto tra quelli 

abitualmente impiegati nella clinica ed utilizzato 

anche per le immagini sottoposte alla valutazione 

clinica 

 

4. Mantenendo i parametri sopra indicati, effettuare le acquisizioni elencate in tabella: 

Gruppo 

serie 

Centratura su 

inserto 

Elementi di 

interesse per 

l'analisi 

Posizione 

relativa centro 

scansione 

N° 

ripetizioni 

Algoritmo di 

ricostruzione 

FBP 

CTP404 Rampe 0 mm 1 
Filtered Back 

Projection (FBP) 

senza utilizzo di 

iterativo 

CTP528 - 10 

mm 
Bead -80 mm 5 

CTP486 
Sezione 

uniforme 
-160 mm 5 

Iterativo 

CTP404 Rampe 0 mm 1 

Iterativo con grado 

di intensità scelto 

liberamente 

CTP528 - 10 

mm 
Bead -80 mm 5 

CTP486 
Sezione 

uniforme 
-160 mm 5 

 

5. Per l'elaborazione, importare le 11 serie di immagini del gruppo FBP nel software AutoQALite 

versione 3.1.5.7 o successiva. 

6. Effettuare l'analisi. 

7. Considerare i valori di risoluzione spaziale in termini di lp/mm al 50% della MTF calcolate 

sull'elemento Bead per le 5 immagini ripetute relative alle acquisizioni FBP: 

fMTF50% fbp
(k)

 = frequenza (lp/mm) corrispondente al 50% della curva MTF relativa alla 

ripetizione k-esima. 

8. Considerare i valori di rumore misurati sulla sezione uniforme centrale (indicati con Noise dal 

software): 



 

Classificazione Consip Public 

Gara a procedura aperta ai sensi del D.Lgs. 50/2016 e s.m.i., per la conclusione di un Accordo Quadro per ogni 
Lotto per la fornitura di Tomografi Computerizzati (TC), servizi connessi, dispositivi e servizi accessori per le 
Pubbliche Amministrazioni ai sensi dell’art. 54, comma 4, lett a), del D. Lgs. n. 50/2016 – ID 1856 

Allegato 4A – Protocollo per l’esecuzione delle prove funzionali 

Pag. 22 di 33 

 

DSfbp 
(k)

  = deviazione standard dei numeri TC nella ROI circolare di diametro pari al 40% del 

diametro del fantoccio, relativa alla ripetizione k-esima. 

9. Calcolare per ogni serie i valori medi: 

DSfbp,media  = MEDIAk=1,…,5 ( DSfbp 
(k)

) 

fMTF50% fbp,media = MEDIAk=1,…,5 (fMTF50% fbp
(k)

) 

10. Utilizzando lo spessore di strato nominale z e il valore di CTDIvol corretto, calcolare il parametro 

Qfbp come segue: 

 
  volmediafbp

mediafbpMTF

fbp
CTDIzDS

f
Q




2

,

3

,%,50

 

11. Importare le 11 serie di immagini del gruppo 2 iterativo nel software AutoQALite versione 

3.1.5.7 o successiva. 

12. Effettuare l'analisi. 

13. Considerare i valori di risoluzione spaziale in termini di lp/mm al 50% della MTF calcolate 

sull'elemento Bead per le 5 immagini ripetute relative alle acquisizioni con algoritmo iterativo: 

fMTF50% iter
(k)

 = frequenza (lp/mm) corrispondente al 50% della curva MTF, relativa alla 

ripetizione k-esima. 

14. Considerare i valori di rumore misurati sulla sezione uniforme centrale (indicati con Noise dal 

software): 

DSiter 
(k)

 = deviazione standard dei numeri TC nella ROI circolare di diametro pari al 40% del 

diametro del fantoccio, relativa alla ripetizione k-esima. 

15. Calcolare per ogni serie i valori medi: 

DSfbp,iter = MEDIAk=1,…,5 ( DSiter 
(k)

) 

fMTF50% fbp,iter = MEDIAk=1,…,5 (fMTF50% iter
(k)

) 

16. Utilizzando lo spessore di strato nominale z e il valore di CTDIvol corretto, calcolare il parametro 

Qfbp come segue: 

 
  volmediaiter

mediaiterMTF

iter
CTDIzDS

f
Q




2

,

3

,%,50

 

17. Calcolare il parametro QF come segue: 

QF = (Qfbp + Qiter) / 2 

 

SCOSTAMENTI ACCETTABILI 
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Gli scostamenti accettabili, pena l’esclusione del concorrente, tra i valori delle misure dei parametri 

dichiarati dal concorrente (DSfbp,mConcorrente, fMTF50%fbp,mConcorrente, DSiter,mConcorrente, fMTF50%iter,mConcorrente) e i 

risultati delle medesime misure ripetute dalla Commissione di gara (DSfbp,mCommissione, 

fMTF50%fbp,mCommissione, DSiter,mCommissione, fMTF50%iter,mCommissione), nell’ambito della verifica funzionale di cui al 

paragrafo 9.4.2 del Capitolato d’oneri, sono i seguenti: 

[(DSfbp,m,Concorrente - DSfbp,m,Commissione) / DSfbp,m,Commissione] ≥ -10% 

[(fMTF50%fbp,m,Concorrente - fMTF50%fbp,m,Commissione) / fMTF50%fbp,m,Commissione] ≤ +10% 

[(DSiter,m,Concorrente - DSiter,m,Commissione)/ DSiter,m,Commissione] ≥ -10% 

[(fMTF50%iter,m,Concorrente - fMTF50%iter,m,Commissione)/ fMTF50%iter,m,Commissione] ≤ +10% 

 

 

5.2.3. PROVA 2B – OMOGENEITÀ DI RUMORE 

1. Posizionare il fantoccio CATPHAN sul lettino, centrandolo rispetto all'inserto CTP404 con 

l’ausilio delle indicazioni laser. 

2. Definire lo strato di riferimento "zero" sul centro dell'inserto CTP404. 

3. Impostare i parametri di acquisizione nel modo seguente: 

4. Mantenendo i parametri sopra indicati, effettuare le acquisizioni elencate in tabella: 

 

Parametro Valore Note 

Modalità Assiale  

Tensione 120 kV Se non disponibile 110 kV 

FOV 250 mm Se non disponibile 240 mm 

Collimazione totale 38 mm - 40 

mm 

Ammesso qualunque valore nell’intervallo indicato. 

Configurazione con il massimo numero di strati 

disponibile con questa collimazione e comunque non 

inferiore a 64 strati 

Spessore strato ricostruito < 1 mm Minimo spessore disponibile 

Tempo rotazione 1 secondo  

Corrente Vedi note Valore di mA tale da ottenere un valore di CTDIvol 

corretto con fantoccio Head il più prossimo possibile 

a 40 mGy (e comunque entro ±2 mGy) 

Matrice 512x512  

Filtro/Kernel ricostruzione Standard Il filtro di ricostruzione deve essere scelto tra quelli 

abitualmente impiegati nella clinica ed utilizzato 

anche per le immagini sottoposte alla valutazione 

clinica 
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5. Importare le 5 serie di immagini (che indichiamo con indice k = 1, 2, 3, 4, 5) dell’inserto 

uniforme CTP486 e l’immagine di riferimento dell’inserto CTP404 nel software AutoQALite 

versione 3.1.5.7 o successiva. 

6. Effettuare l'analisi. 

7. Considerare i valori di rumore per le singole sezioni uniformi riferiti alla ROI circolare di 

diametro pari al 40% del diametro del fantoccio (indicati con Noise dal software). 

8. Data le serie k per ogni slice j-esima (j=1,…,N con N ≥ 64) del modulo uniforme del fantoccio, 

estrarre dai risultati forniti dal software il valore di Noise: 

DSj 
(k)

  = deviazione standard dei numeri TC nella ROI circolare di diametro pari al 40% del 

diametro del fantoccio 

9. Calcolare la deviazioni standard del singolo strato mediata sulle 5 acquisizioni ripetute: 

DSj
 
= MEDIAk=1,…,5 ( DS j 

(k)
) 

10. Calcolare la deviazione standard media tra tutti gli strati: 

DSmedia
 
= MEDIA j=1,...,N ( DS j) 

11. Calcolare la deviazione relativa del rumore del singolo strato rispetto al valore medio: 

R j  = abs[(DSj - DSmedia ) / DSmedia ] 

12. Ricavare la massima deviazione relativa: 

RM = MAXj=1,…,N (R j 
 
) 

13. Ricavare il parametro OR: 

OR = 1 - RM 

 

SCOSTAMENTI ACCETTABILI 

La differenza accettabile, pena l’esclusione del concorrente, tra il valore della misura del parametro 

dichiarato dal concorrente (ORConcorrente) e il risultato della medesima misura ripetuta dalla Commissione 

di gara (ORCommissione), nell’ambito della verifica funzionale di cui al paragrafo 9.4.2 del Capitolato d’oneri, 

è inferiore o uguale a +0,1, ovvero: 

(ORConcorrente - ORCommissione ) ≤ 0,1 

 

 

Gruppo 

serie 

Centratura su 

inserto 

Elementi di 

interesse per 

l'analisi 

Posizione 

relativa centro 

scansione 

N° 

ripetizioni 

Algoritmo di 

ricostruzione 

Unica 

CTP404 Rampe 0 mm 1 
Filtered Back 

Projection (FBP) 

senza utilizzo di 

iterativo CTP486 
Sezione 

uniforme 
-160 mm 5 
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5.2.4. PROVA 2C - RISOLUZIONE A BASSO CONTRASTO 

1. Posizionare il fantoccio CATPHAN sul lettino, centrandolo rispetto all'inserto CTP404 con 

l’ausilio delle indicazioni laser. 

2. Definire lo strato di riferimento "zero" sul centro dell'inserto CTP404. 

3. Impostare i parametri di acquisizione nel modo seguente: 

 

4. Mantenendo i parametri sopra indicati, effettuare le acquisizioni elencate in tabella: 

 

 

Parametro Valore Note 

Modalità Spirale  

Tensione 120 kV Se non disponibile 110 kV 

FOV di scansione 250 mm Se non disponibile 240 mm 

Collimazione totale 38 mm - 40 

mm 

Ammesso qualunque valore nell’intervallo indicato 

Spessore strato ricostruito 5,0 mm Se non disponibile valore più vicino a 5,0 mm, 

nell'intervallo compreso tra 4,5 e 5,0 mm 

Tempo rotazione 1 secondo  

Pitch Vicino a 1,0 Valore disponibile più vicino a 1,0, nell’intervallo 

compreso tra 0,85 e 1,15 

Corrente Vedi note Valore di mA tale da ottenere un valore di CTDIvol 

corretto con fantoccio Head il più prossimo possibile 

a 40 mGy (e comunque entro ±2 mGy) 

Matrice 512x512  

Filtro/Kernel ricostruzione Standard Il filtro di ricostruzione deve essere scelto tra quelli 

abitualmente impiegati nella clinica ed utilizzato 

anche per le immagini sottoposte alla valutazione 

clinica 

Gruppo 

serie 

Centratura su 

inserto 

Elementi di 

interesse per 

l'analisi 

Posizione 

relativa centro 

scansione 

N° 

ripetizioni 

Algoritmo di 

ricostruzione 

FBP 

CTP404 Rampe 0 mm 1 
Filtered Back 

Projection (FBP) 

senza utilizzo di 

iterativo CTP515 Inserti basso 

contrasto 
-110 mm 5 

Iterativo 

CTP404 Rampe 0 mm 1 
Iterativo con grado 

di intensità scelto 

liberamente CTP515 Inserti basso 

contrasto 
-110 mm 5 
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5. Importare le 6 immagini del gruppo ricostruito con FBP (la sezione centrale dell’inserto CTP404 

e le 5 sezioni centrali del CTP515) nel software AutoQALite versione 3.1.5.7 o successiva. 

6. Effettuare l'analisi. 

7. Per ogni immagine k-esima della sezione centrale dell’inserto CTP515 (k = 1, 2, 3, 4, 5), ricavare i 

valori di CNR per i primi 6 inserti supra-slice target di contrasto nominale 1% (diametro 

rispettivamente 15, 9, 8, 7, 6 e 5 mm) e calcolarne la media, indicandola con CNRFBP
(k)

: 

CNRFBP 
(k)

 = [CNR15,FBP
(k) 

+ CNR9,FBP
(k) 

+ CNR8,FBP
(k) 

+ CNR7,FBP
(k)

 + CNR6,FBP
(k)

 + CNR5,FBP
(k)

] / 6 

8. Calcolare quindi la media tra le 5 serie ripetute: 

CNRm FBP= MEDIAk=1,…,5 (CNRFBP 
(k)

) 

9. Importare le 6 immagini del gruppo Iterativo (la sezione centrale dell’inserto CTP404 e le 5 

sezioni centrali del CTP515) nel software AUTOQUALITE v3.1.5.7. 

10. Effettuare l'analisi. 

11. Per ogni immagine k-esima della sezione centrale dell’inserto CTP515 (k = 1, 2, 3, 4, 5), ricavare i 

valori di CNR per i primi 6 inserti supra-slice target di contrasto nominale 1% (diametro 

rispettivamente 15, 9, 8, 7, 6 e 5 mm) e calcolarne la media, indicandola con CNRITER 
(k)

: 

CNRITER 
(k)

 = [CNR15,ITER
(k) 

+ CNR9,ITER
(k) 

+ CNR8,ITER
(k) 

+ CNR7,ITER
(k)

 + CNR6,ITER
(k)

 + CNR5,ITER
(k)

] / 6 

12. Calcolare quindi la media tra le 5 serie ripetute: 

CNRm ITER = MEDIAk=1,…,5 (CNRITER 
(k)

) 

13. Calcolare il parametro finale come segue: 

RBC = (CNRmFBP+ CNRmITER)/2 

 

SCOSTAMENTI ACCETTABILI 

Lo scostamento accettabile, pena l’esclusione del concorrente, tra il valore della misura del parametro 

dichiarato dal concorrente (RBCConcorrente) e il risultato della medesima misura ripetuta dalla 

Commissione di gara (RBCCommissione), nell’ambito della verifica funzionale di cui al paragrafo 9.4.2 del 

Capitolato d’oneri, è inferiore o uguale a +10%, ovvero:  

[(RBCConcorrente - RBCCommissione) / RBCCommissione] ≤ +10% 

 

 

5.2.5. PROVA 2D – ACCURATEZZA DELLO SPESSORE DI STRATO 

1. Posizionare il fantoccio CATPHAN sul lettino, centrandolo rispetto all'inserto CTP404 con 

l’ausilio delle indicazioni laser. 

2. Definire lo strato di riferimento "zero" sul centro dell'inserto CTP404. 

3. Impostare i parametri di acquisizione nel modo seguente: 
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4. Calcolare il passo di scansione sulla base della collimazione totale massima del tomografo 

(NT)max in mm nella configurazione del protocollo di acquisizione e dello spessore di strato 

nominale s: passo = Δz = [(NT)max / 2] – 5∙s 

5. Mantenendo i parametri della tabella precedente eseguire le seguenti scansioni: 

 

 

6. Nella figura seguente sono schematizzate le posizioni relative per le acquisizioni dei gruppi di 

serie indicate, tali che l’inserto CTP591 cada, rispetto al laser, in Z = -32.5 –Δz , poi in Z = -32.5, 

poi in z = -32.5 +Δz, 

 

Parametro Valore Note 

Modalità Assiale  

Tensione 120 kV Se non disponibile 110 kV 

FOV 250 mm Se non disponibile 240 mm 

Collimazione totale 38 mm - 40 

mm 

Ammesso qualunque valore nell’intervallo indicato. 

Configurazione con il massimo numero di strati 

disponibile con questa collimazione e comunque non 

inferiore a 64 strati 

Spessore strato ricostruito < 1 mm Minimo spessore disponibile 

Tempo rotazione 1 secondo  

Corrente Vedi note Valore di mA tale da ottenere un valore di CTDIvol 

corretto con fantoccio Head il più prossimo possibile 

a 40 mGy (e comunque entro ±2 mGy) 

Matrice 512x512  

Filtro/Kernel ricostruzione Standard Il filtro di ricostruzione deve essere scelto tra quelli 

abitualmente impiegati nella clinica ed utilizzato 

anche per le immagini sottoposte alla valutazione 

clinica 

Gruppo 

serie 

Centratura su 

inserto 

Elementi di 

interesse per 

l'analisi 

Posizione 

relativa centro 

scansione 

N° 

ripetizioni 

Algoritmo di 

ricostruzione 

FBP 

CTP404 Rampe 0 mm 1 

Filtered Back 

Projection (FBP) 

senza utilizzo di 

iterativo. 

CTP591 - Δz 
Rampe a 

puntini 
-32.5 mm-  Δz 5 

CTP591 
Rampe a 

puntini 
-32.5 mm 5 

CTP591 + Δz 
Rampe a 

puntini 
-32.5 mm +  Δz 5 



 

Classificazione Consip Public 

Gara a procedura aperta ai sensi del D.Lgs. 50/2016 e s.m.i., per la conclusione di un Accordo Quadro per ogni 
Lotto per la fornitura di Tomografi Computerizzati (TC), servizi connessi, dispositivi e servizi accessori per le 
Pubbliche Amministrazioni ai sensi dell’art. 54, comma 4, lett a), del D. Lgs. n. 50/2016 – ID 1856 

Allegato 4A – Protocollo per l’esecuzione delle prove funzionali 

Pag. 28 di 33 

 

 
 

7. Importare le 16 serie di immagini nel software AutoQALite versione 3.1.5.7 o successiva. 

8. Effettuare l'analisi. 

9. In ognuna delle 15 serie prodotte sull’inserto CTP591 considerare i risultati della slice in cui 

compare la parte centrale del modulo CTP591. 

10. Considerare i risultati, per k = 1,...,15 del test Slice Thickness (Bead Ramp): 

S 
(k)

 = AVG SLICE WIDTH 

11. Calcolare: 

- sulle cinque fette della configurazione n.1 (Z = - ∆z): 

Scaudale = MEDIAk=1,2,3,4,5 (S 
(k)

) 

- sulle cinque fette della configurazione 2 (Z = 0): 

Srif = MEDIAk=6,7,8,9,10 (S 
(k)

) 

- sulle cinque fette della configurazione n.3 (Z = + ∆z): 

Scraniale = MEDIAk=11,12,13,14,15 (S 
(k)

) 

12. Calcolare: 

DevScaudale = abs( Scaudale
 
– Srif) / Srif 

DevScraniale = abs( Scraniale
 
– Srif) / Srif 

US = valore massimo tra devScaudale e devScraniale 

13. Calcolare il parametro finale: 

OSS = 1 - (US / 2) 

 

SCOSTAMENTI ACCETTABILI 

La differenza accettabile, pena l’esclusione del concorrente, tra il valore della misura dei parametri 

dichiarati dal concorrente (OSSConcorrente) e il risultato della medesima misura ripetuta dalla Commissione 

di gara (OSSCommissione), nell’ambito della verifica funzionale di cui al paragrafo 9.4.2 del Capitolato 

d’oneri, è inferiore o uguale a 0,1. ovvero: 

(OSSConcorrente - OSSCommissione ) ≤ 0,1 
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5.2.6. PROVA 2E – OMOGENEITÀ DI RUMORE IN MODULAZIONE VOLUMETRICA 

1. Posizionare il fantoccio conico sul lettino centrando la zona da acquisire con l’ausilio del sistema 

di centratura, avendo in particolare cura che l’asse di simmetria dell’oggetto test sia 

coincidente con l’asse di rotazione del tomografo. 

2. Eseguire una scout/scanogram/topogram/surview in direzione caudo-craniale o Piedi-Testa (in 

configurazione head-first), con corrente circa 1/3 di quella impiegata nella prova 1A. 

3. Impostare i parametri di acquisizione nel modo seguente: 

4. Acquisire quindi la scansione TC impostando gli estremi di scansione in modo da acquisire i 

primi 11 gradoni dell’oggetto test, escludendo i due settori più grandi, in direzione caudo-

craniale o piedi-testa (in configurazione head first), dagli spessori maggiori verso gli spessori 

minori, come segue: 

 

Parametro Valore Note 

Modalità Spirale  

Tensione 120 kV Se non disponibile 110 kV 

FOV 500 mm  

Collimazione totale 38 mm - 40 

mm 

Ammesso qualunque valore nell’intervallo indicato 

Spessore strato ricostruito 2,5 mm Se non disponibile valore più vicino a 2,5 mm, 

nell'intervallo compreso tra 2,0 e 2,5 mm 

Tempo rotazione 1 secondo  

Pitch Vicino a 1,0 Valore disponibile più vicino a 1,0, nell’intervallo 

compreso tra 0,85 e 1,15 

Corrente Vedi note Automatismo per la MODULAZIONE VOLUMETRICA 

della corrente inserito (massima variabilità 

disponibile). 

Impostare l’automatismo per il controllo della 

corrente in modo tale da ottenere, nell’oggetto test 

DOSE AUTOMATICA CONO, una deviazione standard 

dei n. CT nella ROI di riferimento pari a (12 ± 2) HU 

Matrice 512x512  

Filtro/Kernel ricostruzione Standard Il filtro di ricostruzione deve essere scelto tra quelli 

abitualmente impiegati nella clinica ed utilizzato 

anche per le immagini sottoposte alla valutazione 

clinica 
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5. Eseguire in tutto 5 scansioni ripetute. 

6. Eseguire la valutazione solo nei 9 strati centrali che compongono l’oggetto test (escludendo 

cioè anche i due gradoni di dimensioni minime, oltre ai 2 di dimensioni massime che già erano 

stati esclusi in fase di acquisizione). 

7. Per ciascuna serie di immagini, individuare la fetta centrale di ogni scalino dell’oggetto test 

(dalla 1 alla 9, come in figura), distanziate di 20 mm l’una dall’altra. 

8. Collocare le immagini estrapolate in 5 apposite cartelle, una cartella per ogni serie acquisita. 

9. Avviare ImageJ e con il comando “File”→ “Import” → “Image sequence” andare nella prima 

cartella e selezionare la prima immagine  

10. Nella finestra di dialogo che si aprirà automaticamente confermare che sono 9 immagini e dare 

OK. 

11. Cliccare su “Analyze” → “Tools” → ”ROI Manager”, in modo da aprire la finestra “ROI 

Manager”. 

12. Premere il tasto “More” → “Options” e selezionare l’ opzione “Associate “Show All” ROIs with 

slices” , quindi dare OK. 

13. Premere poi il tasto “More” → “Open” e selezionare il set di ROI fornito (file 

“RoiSet_cono_sequence.zip”), facendo attenzione a caricare l’intero file zip senza averlo 

precedentemente decompresso. 

14. Premendo infine la spunta su “Show All” si potrà verificare che ImageJ abbia assegnato in modo 

ordinato le ROI alle slices corrette (vedi figura relativa alla prima immagine). 
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15. Verificare su “Analyze” → “Set Measurements” che siano selezionati almeno i parametri 

“Standard deviation”, “Centroid” e “Display label”. 

16. Se il centro dell’oggetto test non cade esattamente nella posizione (X,Y) = (250mm,250mm), 

sarà necessario traslare tutte le ROI di un numero di pixel opportuno, usando il tasto “More → 

Translate”. 

17. Sulla finestra ROI Manager premere il tasto “Measure” per eseguire l’analisi completa delle 9 

immagini. 

18. Calcolare il valor medio delle standard deviation delle 4 ROI di ciascuno scalino: 

DSi 
(k)

 = media della deviazione standard dei numeri TC nelle 4 ROI posizionate nello scalino i-

esimo del cono, per la serie di immagini k-esima 

19. Ripetere per le altre serie (k = 2, 3, 4, 5). 

20. Ricavare il valore medio per le immagini corrispondente ad ogni spessore per le serie ripetute: 

DSm, i = MEDIAk=1,...,5 ( DSi 
(k)

) 

21. In particolare DS5 = il valore medio ottenuto nello scalino centrale (n.5) 

22. Ricavare i valori minimo e massimo: 

DSmin = MINi = 1,...,9 ( DSm,i ) 

DSmax = MAXi = 1,...,9 ( DSm,i ) 

23. Ricavare il parametro finale: 

ORM = 1 – ( DSmax – DSmin) / 12 

 

SCOSTAMENTI ACCETTABILI 

Gli scostamenti accettabili, pena l’esclusione del concorrente, tra i valori delle misure dei parametri 

dichiarati dal concorrente (DSmin,concorrente, DSmax,concorrente) e i risultati delle medesime misure ripetute 

dalla Commissione di gara (DSmin,commissione, DSmax,commissione), nell’ambito della verifica funzionale di cui al 

paragrafo 9.4.2 del Capitolato d’oneri, sono inferiori o uguali a +10%, ovvero: 

-10% ≤ [(DSmin,concorrente - DSmin,commissione) / DSmin,commissione] ≤ +10% 
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-10% ≤ [(DSmax,concorrente - DSmax,commissione) / DSmax,commissione] ≤ +10% 

 

 

5.2.7. PROVA 2F – RISOLUZIONE SPAZIALE IN MODALITÀ CARDIO 

1. Posizionare il fantoccio CATPHAN sul lettino, centrandolo rispetto all'inserto CTP404 con 

l’ausilio delle indicazioni laser. 

2. Definire lo strato di riferimento "zero" sul centro dell'inserto CTP404. 

3. Attivare il simulatore ECG con una frequenza di 80 bpm. 

4. Impostare i parametri di acquisizione nel modo seguente: 

 

5. Calcolare il passo di scansione sulla base della collimazione totale massima del tomografo 

(NT)max in mm nella configurazione del protocollo di acquisizione e dello spessore di strato 

nominale s: passo = Δz = [(NT)max  / 2] – 5∙s 

6. Mantenendo i parametri della tabella precedente eseguire le seguenti scansioni: 

 

Parametro Valore Note 

Modalità Assiale Acquisizione prospettica sincrona con il gating 

cardiaco simulato 

Tensione 120 kV Se non disponibile 110 kV 

FOV scansione  Cardio  

FOV visualizzazione 250 mm Se non disponibile 240 mm 

Collimazione totale 38 mm - 40 

mm 

Ammesso qualunque valore nell’intervallo indicato. 

Configurazione con il massimo numero di strati 

disponibile con questa collimazione e comunque non 

inferiore a 64 strati 

Spessore strato ricostruito < 1 mm Minimo spessore disponibile 

Tempo rotazione < 0,4 secondi  

Corrente Vedi note Valore di mA tale da ottenere un valore di CTDIvol 

corretto per fantoccio body il più prossimo possibile a 

15 mGy (e comunque entro ±2 mGy) 

Matrice 512x512  

Filtro/Kernel ricostruzione Standard Il filtro di ricostruzione deve essere scelto tra quelli 

abitualmente impiegati per esami cardiologici 
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7. Importare le 16 serie di immagini nel software AutoQALite versione 3.1.5.7 o successiva. 

8. Effettuare l'analisi. 

9. In ognuna delle 15 serie prodotte sull’inserto CTP528 considerare i risultati della MTF della slice 

in cui compare il Bead con la massima intensità: 

fMTF50% 
(k)

 = frequenza (lp/mm) del 50% della curva MTF sull’immagine k-esima 

10. Calcolare il valore medio: 

f=MTF50%= MEDIAk=1,…,15 (fMTF50% 
(k)

) 

11. Considerare come parametro finale: 

RSMC= fMTF50% /7 

 

SCOSTAMENTI ACCETTABILI 

Lo scostamento accettabile, pena l’esclusione del concorrente, tra il valore della misura del parametro 

dichiarato dal concorrente (RSMCConcorrente) e il risultato della medesima misura ripetuta dalla 

Commissione di gara (RSMCCommissione), nell’ambito della verifica funzionale di cui al paragrafo 9.4.2 del 

Capitolato d’oneri, è inferiore o uguale a +10%, ovvero: 

[(RSMCConcorrente - RSMCCommissione )/ RSMCCommissione ] ≤ +10% 

 

Gruppo 

serie 

Centratura su 

inserto 

Elementi di 

interesse per 

l'analisi 

Posizione 

relativa centro 

scansione 

N° 

ripetizioni 

Algoritmo di 

ricostruzione 

FBP 

CTP404 Rampe 0 mm 1 

Filtered Back 

Projection (FBP) 

senza utilizzo di 

iterativo.  

CTP528 - 10 

mm -  Δz 
Bead -80 mm -  Δz 5 

CTP528 - 10 

mm 
Bead -80 mm 5 

CTP528 - 10 

mm +  Δz 
Bead -80 mm +  Δz 5 


